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Introduction
In late 2016, a child in Dallas asked her family’s
Amazon Echo “Can you play dollhouse with me
and get me a dollhouse?” The device ordered a
dollhouse for her. When a news anchor repeated
the story, the phrase “Alexa ordered me a
dollhouse” triggered Amazon virtual personal
assistants (VPAs) in the homes of viewers to
also order dollhouses for their unwitting owners.
In spring 2017, an advertisement for Burger King
included the line “OK Google, what is the Whopper
burger?” Which prompted any Google Home VPAs
within earshot to begin describing the burgers to
their owners?
In the future – perhaps the near future – your
autonomous car will not only decide when it needs
maintenance, but shop for the best price, schedule
an appointment and drive itself to the shop. If it is
an electric vehicle, it will shop for charging stations
and drive itself to the location with the best price
and the most open charging poles. A little further
in the future it might even own itself and run its
own ride-sharing service.
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T

hese are not just cute anecdotes or isolated examples. They’re
the opening shots in an economic, cultural and possibly political
revolution in which products and services are designed primarily
not for people, but for the increasingly smart machines we will trust
to make purchases for themselves as well as for their human owners.
Increasingly, such machines are becoming autonomous economic agents
not only supplementing human judgement but sometimes replacing it.

Marketing Fraud Writ Large
What humans can invent, humans
can cheat – as we’ve already seen
in the Burger King ad. Expect more
sophisticated “gaming” of machine
to machine marketing channels,
requiring preventive/remediation
steps in areas such as:
• How secure are blockchains,
especially with challenges such
as how to assure the identity
of blockchain nodes (and human
users) and the threat that
quantum computing can crack the
strongest encryption.
• How to prevent the compromise/
corruption of data such as
user location, customer ratings
of products/services or past
purchases that might affect
which products or services the
algorithm recommends. (One
report suggested that Burger King
edited the Wikipedia entry for
its Whopper before running the
ad to make the entry read like an
(continued on next page)

Combine these rising levels of machine intelligence
with blockchain’s ability to provide secure, immutable
transactions without a middleman and the upside is
transformative. Think of a decentralized economy
that allows smart machines to find each other and
complete transactions at zero cost. Think of the
efficiency when new providers of goods and services
can compete regardless of location or the quality of
their local banks and legal systems. Think of the new
business models enabled by fast, secure, zero cost
nano transactions on blockchain technology or of smart
devices in the Internet of Things (IoT) generating,
sharing and even trading data for profit.
The building blocks for this new reality are already
falling into place. Consulting firm Gartner estimates
the IoT will comprise 26 billion devices and a $1.9
trillion economy by 2020, and the World Economic
Forum estimates that by 2025 10 percent of all global
domestic product will be stored in the blockchain.
The result are new “algorithmic profits” in which
blockchain-based smart contracts allow consumers,
or even self-owning entities such as fleets of
autonomous vehicles that are electric and shared
(FAVES) to monetize their value at the edge of the
network. For example, such a self-owned vehicle could
make money by selling part of its electric charge back
to the electric grid at a charging station, or by selling
the transport of people or goods, in a direct machine
to person or machine to machine transaction. By using
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advertisement.) That raises the
possibility of customers getting
tainted information, and that a
hacker could edit the entry with
false, defamatory or embarrassing
content.
• How to prevent, or at least assure
the disclosure of, the promotion
of products and services in
return for payment. In the worst
case, the machine may make a
recommendation based only on
the payments it receives from
the seller without disclosing that
arrangement to the buyer. In
the best case, the machine uses
the data it receives to choose
the best possible offer for the
customer. In either case, everyone
from marketers to regulators
needs to realize the need for new
thinking, new designs and new
decisions about what is desirable
in the machine economy.
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blockchain, this transaction can happen without the
expense, delay or loss of control of going through a
central authority such as a bank.
However, the failure to master machine-centered
design poses massive and perhaps existential
challenge for the many companies that are often still
learning to use “human-centered” design. Such humancentered design thinking uses detailed observations of
people and multiple iterations of businesses processes
and products, Web sites and user interfaces to create
innovative products and services to attract the
most customers. In the machine-centered world, this
design process must be adapted to the algorithms
and software that will increasingly make buying
(and selling) decisions on their own. For example,
how do you convince Alexa (the voice on Amazon’s
VPAs) to recommend your dish soap to a given set of
customers, or a smart thermostat to order electricity
and maintenance from you rather than a competitor?
In the human centered world, successful innovation
means finding a good fit with unmet customer needs
and achieving high traction in the marketplace1. In the
machine centered world, successful innovation means
finding and filling the unmet needs of your machine
“customers” and gaining traction in a world
of autonomous, algorithmic customers.

The Technology Drivers
The building blocks of this revolution include:
• Increasingly intelligent and capable voice recognition. This is the
seductively easy to use interface into the networked, intelligent,
“machine first” world.
• Low price and easy to use VPAs that bring natural language queries
from the mobile, smartphone environment to any room in the home.
• Integration of such VPAs with e-commerce ecosystems such
as Amazon, voice-enabling existing capabilities such as product
recommendations and one-click ordering.

1

Sauberschwarz/Weiss (2017): “How corporates can win the race against disruptive startups”, in: “Digital marketplaces unleashed”,
Linnhoff-Popien, Schneider, Zaddach (Eds.), Springer, Berlin, 2017 http://www.springer.com/br/book/9783662492741
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• “Smart” appliances and control systems (ranging from door locks
to thermostats) and IoT devices and sensors that can assess their
surroundings, gather information from other devices, and use
Internet connections to respond to commands from their owners
or take action on their behalf.
• Artificial intelligence (AI) and other analytics that gain insight from
big data, taking into account not only customer demographics and
purchase history but context such as weather, a user’s location and
activity, or social media and other behavioral clues to what the
human speaker might want or need. In pure machine to machine
interactions, it might consider production trends to order raw
materials for a warehouse, and pricing trends (such as peak period
electric charges) in deciding when to charge an autonomous electric
vehicle or where to build and deploy autonomous vehicles2.
• The emergence of decentralized, peer to peer services (such as the
Arcade City ride sharing service) and of autonomous, perhaps selfowning vehicles that could sell their own services through such
networks, with the ordering being done by voice.

All this creates a new class of “machine” customers that today helps
humans decide what to buy, when to buy it, how much to pay for it
and from which provider to purchase it. In the fast approaching machine
age, everything from autonomous cars to swarms of intelligent nanosatellites to manufacturing robots will purchase products and services
for themselves more quickly and less expensively than any human could.
(See Figure One.)
2

Goodbye car ownership, hello clean air: welcome to the future of transport. World Economic Forum December 16, 2016.
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Figure One:
Tomorrow

> Transactions amongst people and companies
> Transactions being orchestrated by legacy processes
and systems with many manual activities involved
> Machines not perceived as the customers of the future;
a strategy for ‘machines as customers’ is needed

> Transactions amongst
People & companies,
Machines (M2M)
- People, companies & machines
> Transactions highly automated & orchestrated via
Blockchain with massive impact on today’s processes

Customer Segments

Today

Example Insight
Banks not yet prepared
to offer products for the
M2M economy.
People

Companies

M2M

Global players such as
VISA starting now to
invest into Blockchain
and IoT to offer nanotransmission services.

Growing share of M2M Transactions
Source:
M2M

Carsten Stocker (innogy Innovation). US and EU Research / Government Projects. Investment Banking Reports.
Machine to Machine Transactions
Not yet existing transactional interfaces into M2M economy

Designing products and services for this new breed of “machine” customer
is a massive challenge, and opportunity, for producers of every product
and service on the planet.

The Machines Behind the Machines
The word “machines” is misleading as most often the “purchaser” will
not be the physical devices that appears to be facilitating the transaction
(such as a smartphone or VPA) but the algorithms and network that
matches buyers and sellers. (See Figure Two.) Among the components in
this “machine” marketers will need to design for include:
• The APIs through which information aggregators, peer to peer
networks, cloud-based analytics platforms or ecommerce providers
accept and share information about buyers and sellers.
• The algorithms that decide how to rank various metrics (such as price,
location, delivery time and product ranking) in determining which
products or services to offer which customers at which times, and
which products or services to buy at what price.
© Copyright innogy Innovation GmbH
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• The blockchains (distributed ledgers) that reduce cost and delay in
transactions by eliminating arbiters and gatekeepers such as banks,
and enable autonomous (and even self-executing) machine to
machine transactions.
The autonomous physical robots that will do routine work from delivery
to cleaning to security monitoring and that will need goods and services
(such as supplies and maintenance) to complete their work.

Figure Two:
Effects of Machine Centered Design on Everyday Life
< Your utility just hiked peak period pricing
because of the heat wave. I’ll turn the temp
up to 78 until the sun goes down. >

< The 24-pack of contact lenses you need
just went on sale for $99 from a top
rated seller. Want me to order them? >

Virtual Personal Assistant (VPA) finding
a good deal for a customer online.

A smart thermostat learning of a good
deal on electricity, and switching providers
on its own to save a customer money.

< Milk is overdue.
Order new milk.>

A smart refrigerator that recognizes what its
owner is running out of and orders it.

< I need best pricing
on a Maytag
MAV2755WW
drive belt and a
technician ASAP.>
A smart washing machine recognizes a belt is
about to fail and automatically finds best, most
reputable repair person and schedules an appointment
for a time that fits the owner’s calendar.

< Labels almost empty. Big heat
wave coming down South. Order
100,000 more labels.>

A machine on a production line orders raw materials from a supplier.
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Designing for Machines

My Robot Will See Your
Robot in Court
In today’s society, liability issues –
who pays if something goes wrong
– must be resolved before any new
product or service can gain widespread
acceptance. The same is true for the
machines that will increasingly make
decisions for us. If an autonomous
device (or process) becomes causes
financial or other harm, who is
responsible?
Designers of such systems should
begin working with regulators,
lawmakers and lawyers now to
understand the risks and design
the legal/regulatory frameworks
that provide proper protection to
all stakeholders. One example, from
an EU proposal, suggests that “…the
greater a robot’s learning capability or
autonomy is, the lower other parties’
responsibility should be, and the
longer a robot’s ‘education’ has lasted,
the greater the responsibility of its
‘teacher’ should be.”

• Currently, most companies focus on design thinking
or similar forms of human-centered design. They
combine these methods with lean and agile
development for fast prototyping and user testing,
but with a clear focus on human customers.
They seek to understand human needs through
observation, interviews and market research,
and develop ideas to meet those needs through
brainstorming and “green field” thinking. They then
use fast prototyping, minimum viable products
(MVPs) and user testing to speed new products
and services to market3. (See Figure Six.)
Machine-centered design requires many of the same
steps, but implemented very differently to satisfy our
new, non-human customers. Developing a “hierarchy
of needs” for machines, and defining the machine road
map and a machine’s “customer journey” can help you
define and meet those needs.

What Your Machines Want, and Why
A “Hierarchy of Needs” for Machines

The “machine” for which products and services are
designed might be an autonomous car, an industrial
robot, or a deep learning algorithm parsing a customer’s
economic activity. This machine “customer” might be
empowered to make a purchase decision itself, only
assist with a purchase or recommend a purchase, or serve as the interface
for the request, such as Amazon Alexa or another smart speaker.

One way to identify unmet machine needs is use the “innogy pyramid
for machine needs” developed by the Machine Economy Lighthouse in
the innogy innovation hub (See Figure Three) and adapted from Abraham
Maslow’s pyramid of human needs.

3

Sauberschwarz/Weiss (2017): Das Comeback der Konzerne, Vahlen Verlag (German)
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Figure Three:
Maslow Pyramid of Humans Needs vs. innogy Pyramid of Machine Needs
Basic Human Needs
Self Actualization - Fulfillment, Purpose,
Morality, Creativity

Esteem - Respect, Recognition, Individuality

Basic Machine Needs
Self Actualization - Machine Consciousness, Artificial
Feelings, Creativity, Ethics

Esteem - Attention & Reputation Systems,
Cognitive Capabilities

Social Belonging & Cooperation - Machine

Love & Belongingness - Friendship,

Identity & Ownership, Machine Collaboration &
Relationships, Data Privacy

Family, Intimacy

Safety Needs - Home, Health, Job,

Safety & Security- Reliable Infrastructure,
Cryptographic Ciphers, Defense
Mechanisms, Maintenance, Wallet

Finance

Biological & Physical Needs -

Physiological Needs - Energy,

Infrastructure, Computing Power,
Connectivity

Air, Water, Food

For humans, the base of the pyramid consists of physiological needs such
as air, water and food. Once those have been satisfied, the next layer
involves safety and security (such as home, health and a job,) followed by
social belonging, self-esteem, and finally fulfillment, purpose, morality and
creativity leading to self-actualization – becoming everything that person
is capable of becoming based on their capabilities and desires. In creating
new products and services, designers try to understand where the target
human customer is in the hierarchy and how their product or service can
meet, or promise to meet, their needs at that level.
For machines, the lowest level of the pyramid might consist of electricity,
computing power and network connectivity. The next level up provides
safety and security, provided by firewalls and other cyber defenses, as
well as cryptographic ciphers to protect its data.
The next layer up for a machine might be “social belonging and
cooperation,” meaning the machine has a discoverable identity, can make
its presence known to other devices, and can control the privacy of its
own data.
Moving to the next layer provides the machine equivalent of self-esteem.
This requires “attention” systems that allow autonomous systems to find
and identify each other, and reputation mechanisms such as metadata
that track how others have ranked the quality of their goods and services.
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All these capabilities will allow the machines to autonomously choose
which counterparties they will share data, value or services with, and on
what terms.
Just as “self-actualization” means different things for different people,
it will mean different things for different machines. For a VPA it might
mean detecting even the most subtle stress notes in its owner’s voice
and automatically suggesting music that has calmed them in the past. For
an autonomous nano-satellite it might mean choosing its own surveillance
targets that result in higher profits for its commodity-trading or agribusiness customers.
One possibility is that as machines become
ever more capable, this self-actualization may
include the ability to experience and express
feelings, creativity and empathy. At this stage,
they may be able to engage with humans as
peers, allowing them to tap Big Data analytics
to sense unmet human needs and create new
products, services and business models to
serve them.
If this “self-actualization” only meets the
needs of the machine, the very real fear is they
could use their increasing and perhaps superior
powers to enslave or even exterminate
humans to build a society around their own
ever-increasing powers and needs. Elon Musk,
the CEO of electric car maker Tesla and SpaceX has said that AI is an
existential threat that must be regulated before it is too late4 and famed
professor Stephen Hawking has echoed such fears, saying AI will be either
the best or worst thing to happen to humanity5.
This profound question has many companies (including a consortium of
AI leaders including Amazon, Facebook, Google, IBM and Microsoft6) as
well as the nonprofit OpenAI7 looking for ways to ensure “safe AI” – that
machines use their power for good, not evil. In Germany, the federal
minister of justice has called for greater government scrutiny of the
algorithms that control online information flow to help assure they do
not promote discrimination or try to manipulate the democratic process8.
4

The Guardian: Elon Musk: regulate AI to combat ‘existential threat’ before it’s too late, https://www.theguardian.com/
technology/2017/jul/17/elon-musk-regulation-ai-combat-existential-threat-tesla-spacex-ceo

5

The Guardian: Stephen Hawking: AI will be ‘either best or worst thing’ for humanity.

6

The Partnership on AI to benefit people and society.

7

OpenAI

8

Spiegel online: Regulation of Internet Corporations
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The OpenEth9 organization is working to create a crowd-sourced, dynamic
“dataset of ethics” that will use contributions from people around the
globe to teach smart machines how to react ethically to various scenarios.

The Machine Life Cycle
The second tool to understand basic needs of machines is the machine
life cycle, from the point where the machine is “born” as it is designed (by
humans or other machines) to its end of life when it is decommissioned
and its resources (such as computing, storage and network capacity)
is recycled for other uses. When designing a product or service for a
machine, it’s necessary to take into account which stage(s) in the machine
life cycle the product or service is meant to address, and how your
product or service must change to meet the machine’s needs through its
life cycle (See Figure Four.)
For example, in the “transmit and track” phase of an electric vehicle’s
ability to sell electricity back to the electric grid, the vehicle must be able
to advertise its presence and capabilities to the grid and to other electric
vehicles. In the “analyze, optimize and personalize” stage it needs to
analyze data on demand for its electricity and the price customers paid
for it, and potentially change its generation and pricing strategies.

Figure Four: The Machine Life Cycle
</>
Design
>
>
>
>
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Create Design
Protect Design
Transfer Design
Receive Payment

Create Physical
& Digital Object
> Confirm Production
> Create Object
Identity
> Receive & Process
Design
> Produce & Tag
Object
> Transfer Ownership
> Create Digital Twin
> Pay Production

Transmit &
Track
> Distribute & Deploy
Object
> Connect to Internet
> Connect to Smart
Home / Smart City /
Smart Factory
> Provide Access
> Gather Data
> Track Object
> Sync Digital Twin

Aggregate &
Collaborate

Analyze,
Optimize &
Personalize

> Exchange and
consolidate data
> Generate data
drive insights
> Aggregate assets
and data
> Share benefits
> Establish Hybrid
Teams 10

> Analyze data
Optimize
parameters
> Write new code
> Receive updates
> Provide
personalized
services
> Share benefits

Transact &
Transform
> Process data with
machine intelligence
> Make machine
decision
> Transform input to
output
> Provide human
machine interface
> Receive and pay
services
> Manage wallet & P/L

Recycle
>
>
>
>

Transfer data
Decommission
Recycle
Create raw material
recycling trail
> Release deposit

https://www.openeth.org/

DFKI: Hybrid Teams: Flexible Collaboration Between Humans, Robots and Virtual
Agents, http://www.dfki.de/lt/publication_show.php?id=8634
10
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Designers of products and services will need to understand their changing
needs and plan for them. Just as a human will need retirement planning
at a certain age, an electric vehicle of a certain age may need a new
battery or to shop to recycle itself at the best price. More fundamentally,
if an aging machine is using an outdated API or blockchain platform, how
long is it worth it for other machines to keep supporting these outdated
platforms and keep selling to an aging machine? This would be the
machine-to-machine equivalent of Adobe abandoning its Flash media
player 11 software after complaints from Apple and other technology
companies about its bugs and security vulnerabilities.

The Machine Customer Journey
The third tool in effectively designing for machines is an understanding
of the machine customer journey. (See Figure Five.) The human customer
journey typically progresses from awareness of a product or service (or
the need for it) to consideration of a specific provider, acquisition of the
product as well as service or support for it, and (hopefully) loyalty to the
product or brand, leading either to ongoing sales or recommending it to
others. In the selling process, marketers take great pains to understand
where a customer is in this journey and tailor communication about their
offering accordingly.
Machine customers will go through a similar journey, but with each
step conducted over peer to peer networks, executed by algorithms
that learn and refine their selections over time, and augmented by
attention and reputation systems such as on-line rankings. In the case
of our electric vehicle, the “awareness” stage begins when it realizes it
needs a recharge, a new tire or a cleaning and advertises its needs to
other machines or service providers. The consideration stage happens
when various machine “providers” advertise their presence, the pricing,
availability, delivery times and other factors. The acquisition is executed
via peer to peer smart contracts over a blockchain, as is the ongoing
service (perhaps with additional rounds of
awareness, consideration and acquisition of
new services as needed.) Among machines,
the transaction may flow both ways, with
a smart contract “agreeing” to sell power
from an electric vehicle back to the grid, or
a manufacturing robot selling data about
its operation in return for a discount on
maintenance or parts. In the machine to
machine world, the buyer expresses their
loyalty through a ranking, on the blockchain,
of how well the provider delivered what
they promised.
11

Fortune: Adobe Plans to Kill the Flash Media Player.
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At each stage in the design process, this machine customer journey
can help product and service providers fine tune their offerings. In the
“awareness” stage they can ensure it is listed on the appropriate online exchanges, with data describing it in the proper machine-friendly
format and providing all the information the requesting machine needs.
In the purchase stage, they can assure the transaction was accurate
and complete, and in the service stage “meter” the state of the
consuming machine to be sure they are offering the right maintenance or
replenishment services at the right time.

Figure Five: The Machine Centered Customer Journey
Person Centered Customer Journey

Machine Centered Customer Journey

!

!

+ Battery LOW

Awareness

Fuel LOW

< Fast charging @
36¢ / kWh. >

Consideration

< Gradual charging
@ 29.2¢ / kWh. >

< Occupied for the
next 20 minutes. >

< 3 plugs available
in 20-30 minutes. >

Acquisition

“I was overcharged!
Who can I call to
correct this?”

Service

< Battery cell 33%
degraded, may need
replacing. >

< Was charging rate,
price and availability
as promised? >

< Confirming your purchase of 3.6 kW
charged to wallet XXX347. >
“Those guys not only
erased my overcharge, but
gave me a $25 gas card.
Pretty neat!”

Loyalty

< Charging availability < Lowest prices
as promised. >
in the area. >
< Accurate detection of impending
battery problem. >
< Fastest charging speed! >
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Designing for Machines – the Process
Using tools such as these, here is how the essential elements in the
design process differ in a machine-centric rather than a human centric
world. (See Figure Six.)

Figure Six: Human Centered Design vs. Machine Centered Design:
Elements in the Design Thinking Process
Elements in
Innovation
Process
Goals and
criteria
Opportunity
spaces

Human Centered Design
•

•

Business related

•
•

Serving the (human) society
Based on trends, big data,
technology research

•

Based on trends, customer data
and technology research

•

Based on company and employee •
abilities
•
Primary market research:
Customer interviews, focus
groups, observations, ethnology,
transferred into insights

Based on company, employee
and machine abilities
Primary market research: Data
mining and analytics, technical
expert interviews transferred
into parameters

•
“Personae” as visualization for
target group segments
Needs based on Maslow pyramid •
for humans

Machine specs as visualization
for “target group” segments
Needs based on Maslow
pyramid for machines

•

Customer pain points: Unsatisfied •
needs from specific persona

•

Customer journey to identify pain
points along specific process
•

Machine pain points: Unsatisfied
needs that hinder specific tasks
for specific machines.

•
Insights
•
•

Needs

Business related

Machine Centered Design

•

Best practices, analogue
examples, look to the future

Inspirations

•

Machine journey and machine
life cycle to identify pain points
along specific processes
Best practice code, open
source, patents, technology
research, analogue tasks, human
interactions as analogy, look to
the future
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Elements in
Innovation
Process

Human Centered Design

Machine Centered Design

•

B2B, B2C offers (products,
service processes ...)

•

M2M, B2M offers (services,
products, functionalities ...)

•

Brainstorming to quickly
generate ideas

•

Systematic ideation to
generate ideas based on
relevant parameters

•

AI supported idea generation,
combining different inputs,
needs, and parameters
Value proposition with clear
value for machine (enable task)

Ideas

Innovation
concepts
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•

Value proposition with clear
value for customer (solve need)

•

•

Business model canvas

•

•

Customer experience / UX design

Business model canvas adapted
for machines

•

Machine integration, e.g. API
design, language, protocols,
parameters

•

Machine learning and selflearning
Stakeholders include project
owner, machine (self-owned),
investor/owner/manufacturer,
programmers, partners

•

Stakeholder: Project owner,
customer, employees, partners

•

Fast prototyping, testing with
MVP, agile development

Implementation

•

•

Agile development, A/B testing,
fast scaling, Tech review

•

Design for continuous
improvement by the machine
customers

•

Machines must be ready for
self-improvement

•

“Safe AI” must be implemented
to assure human safety
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Identifying needs and opportunities:
• In the human centered world this is based on analysis of human
needs, social and market trends. This often includes traditional
market research, focus groups, customer interviews and ethnographic
research observing how customers use products and services at
work or at home. Target market segments are often described as
human “personas” with characteristics such as gender, age, education,
occupation, roles and responsibilities and even hobbies. The customer
pain points represent unsatisfied human needs at varying levels of
the Maslow pyramid, the customer life cycle or journey, with products
or services designed to move the customer to the next stage in it.
• In the machine centered world, needs and opportunities are identified
primarily by mining and analyzing data on machine to machine
transactions, as well as “state” information such as their location and
performance. Target markets are described as different classes of
machines with different ranges of abilities such as computing power,
network bandwidth and storage. Pain points are represented as, for
example, unsatisfied needs in the Maslow pyramid that prevent the
machine from performing specific tasks or information a machine
needs to move to the next step in its journey from awareness
to loyalty. The goals, criteria and opportunity spaces should be
defined by all relevant stakeholders. In human-centered design, the
“stakeholder map” is easily defined and relatively static, including
managers, employees, customers, partners and suppliers. It is very
different in a fast-paced technology landscape – see sidebar (next
comment)

Mapping Your Stakeholders
Every product, whether physical or virtual, has
stakeholders – people and/or institutions who
have a stake in its success. These range from
business managers, employees and shareholders
to suppliers, customers, business partners and
regulators.
Mapping these shareholders (by factors such as
the degree of their influence, their importance
and their support for the new offering) is
relatively straightforward in the “people”
economy. When producing a social media

application, for example, stakeholders would
include users, advertisers, potential partners,
and potentially regulators. While the specific list
of stakeholders might change very often, the
types of stakeholders will remain fairly static.
The machine to machine world changes far
more often and dramatically, producing different
types of stakeholders much more often. The
reasons, and the implications for those designing
for machines, include:
(continued on next page)
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New types of devices: Each new type of
device becomes a new stakeholder with
specific needs and commercial potentials.
Autonomous vehicles that can shop for
their own tires will create a new, different
set of stakeholders for tire manufacturers.
A blockchain-enabled sensor that can track
temperature and location as well as the
source of a product will create stakeholders
all the way from the farm to the table, each
with different needs.
New capabilities in smart or autonomous
devices: The more and different types of
data that, for example, a wearable health
sensor captures, the more and different
stakeholders will be interested in using that
data. The ability to capture signs of stress
or specific speech patterns in the owner’s
voice might, for example, make an addiction
treatment center or a probation officer a
stakeholder by indicating the user might
be at risk of a relapse. When clusters of
low-cost nano satellites can cooperate in
earth monitoring tasks, the other satellites
become stakeholders, as buyers and sellers
of data or observing time.
New data analysis capabilities: As the
algorithms that analyze Big Data capture
new insights, they will also create new

potential customers and regulatory concerns
and, thus, new stakeholders. As improved
algorithms predict more types of machine
failures, they create more stakeholders in
those who sell the parts and services that
can prevent such failures.
•

New transaction platforms: The growth of
decentralized transaction platforms such as
blockchain slash the time, effort and cost of
buying and selling by eliminating middlemen.
This democratization of commerce allows
new buyers and sellers to enter the
marketplace, selling new types of goods
and services in new business models. Each
of these rapid-fire changes creates new
stakeholders with new needs. By allowing,
for example, millions of people in under- or
unbanked areas to participate in ecommerce,
blockchain requires meeting not only their
needs but the needs of regulators and
banking officials in their geographies. Such
new platforms may even be dynamically
created in real time to meet rapidly changing
requirements.

The lesson: Machine-centered design may focus
on machines, but the rise of intelligent, decisionmaking devices creates a fast-changing cast of
stakeholders you must also take into account.

Designing products and services:
• In the human centered world this is built around the capabilities and
desires of the target customer (described as concrete “persona”). The
effectiveness of the design in meeting their needs is based, again, on
interactions with and observation of human subjects, with a heavy
emphasis on the user interface as experienced by a human (sight,
touch, and hearing.) The effectiveness of the product or service is
measured, again, by how well it meets human needs to move a human
further up the human Maslow pyramid.
• In the machine centered world, the innovation might be driven by
examining where a device or application is on the innogy Pyramid of
Machine needs, and what services it could provide an organization (or
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society) if it moved further up the pyramid. The effectiveness of the
design is measured by how well it meets the technical needs of the
device or software for which it is designed, such as efficiency of the
code, compliance with the APIs or protocols through which a device
or application is addressed, and speed or reliability of the required
communications or transactions.

Delivering products and services as quickly as possible:
• In the human centered world this is accomplished through agile
development methods including SCRUM, rapid prototyping, MVPs
(minimum viable products), and DevOps.
• In the machine centered world, these mechanisms are also used, but
with the assessment of the solution at each stage relying far more on
data analytics and machine learning than “analogue” conversation with
or observation of humans. Automated design/test cycles with large
numbers of devices or applications in the cloud allow for faster, lower
cost refinement of products and services than with human-centered
design.
As innovators understand the needs (and potential) of machines rather
than humans, they can begin exploring new opportunities for collaboration
across industries and borders. This might include an electric utility
publishing APIs so it’s charging stations can broadcast their availability
and prices to fleets of autonomous electric vehicles, or delivery drones
dynamically offering security footage to a traffic-tracking application as
they travel across a metropolitan area.

Designing for Machines – Infrastructure and Skill
Designing for machines requires new infrastructure, processes
and capabilities adapted to this new class of customers. This
includes a staff with a timely, in-depth understanding of the logic
of machines, the types and volumes of data they generate and
consume, and the algorithms and deep learning mechanisms
needed to generate insights and decisions from that data.
Analysts must understand the business context in which the
data, algorithms and insights exist in order to focus their
efforts on the “sweet spots” of maximum opportunity.
On the legal and governance front, machine to machine
commerce will require common standards for mutually
usable smart contracts that ensure both sides
understand what the other is offering, as well as the
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ability to make counteroffers and to signal acceptance or rejection of
them. It will also require laws and regulations that allow for, standardize
and govern transactions in the machine to machine world, and provide
meditation and conflict resolution comparable to those in the person
to person world. (For example, can a machine have a bank account and,
if so, who or what has “signing” authority for it?) Finally, it will require
mutually agreeable, secure and immutable payment mechanisms,
including agreement on which blockchain(s) and cryptocurrencies to use.
Finally, and most importantly, as smart machines becomes more capable,
governments and citizens will need to be sure they will be used to help,
rather than exploit, their human creators.
Among the technical capabilities required are access to the
APIs needed to gather the required data, and authentication
to prove the supplier is who they claim to be, proper
formatting of the data to be shared, support for the
level and type of encryption needed to protect the
information and the ability to fine tune, in real time, how
information is presented to the intelligent ecosystem
and eventually the end device, such as a VPA based on
changing business conditions.
The data that must be shared includes not only what the machine (or
the human it represents) needs (for example, power charging, preventive
maintenance or replacement filters for an industrial pump) but the relative
importance of factors such as location, how soon the product or service is
needed, the quality or level of service required, the price the customer will
pay and historic data for the algorithms and smart contracts to consider
as they evaluate the current request.
The amount of information required, and the analysis performed on it, can
be daunting. For an autonomous electric car, the information required to
respond to a seemingly simple charging requests might include how much
of a charge it needs and how quickly in order to complete it’s current and
projected rides, at the lowest cost and losing the least time for charging.
The car must factor in, among other thing, the expected demand for rides
during the time it needs to charge, as well as historic pricing patterns
for power during this time and current and expected congestion on the
routes it will take.
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Monetizing the Machine to Machine World
In the machine to machine economy,
technologies such as blockchain reduce
transaction costs to nearly zero. This is good
news for buyers and sellers but bad news
for banks, credit card processors or other
middlemen. As innovators design products and
serviced for machines, rather than humans,
they will need to take into account who makes
money, and how, at what step in the process.

For example, when an autonomous electric
vehicle wants to make money by selling
electricity to the grid, it can charge a premium
by, say, waiting for a peak demand period when
prices are highest, or even “stabilizing” demand
by traveling to a charging station overloaded
with demand and transferring extra electricity
to another vehicle or by selling the flexibility of
its battery to third party aggregator.

The answer depends on whether the machines
provide their services primarily to humans (think
of self-driving cars transporting people or a VPA
ordering groceries for its owner) or to other
machines (think a manufacturing robot ordering
maintenance or raw materials.)

In both cases, the matching of supply and
demand and the transactions themselves might
be performed on blockchains and facilitated
by APIs, interfaces and protocols that might
themselves provide value as “gateways” to the
wider community of buyers and sellers.

When the customer is a human, the service can
create value (for which it can charge a price) in
the form of greater convenience, flexibility, or
ease in either ordering the service or consuming
it. Even if the basic service (transportation)
becomes a commodity and falls in price, a
human might still pay more to go by the
shortest route or, conversely, a longer route to
pick up a friend or do a chore.

Aggregation software that bundles and
matches demand will run in a decentralized
fashion among network nodes to optimize
the efficiency of services such as utility and
transportation grids. The software that utilizes
algorithms that provide the greatest returns
for buyers and sellers can command a tiny
transaction fee that will generate algorithmic
profits for the owners of those protocols or
algorithms. As AI allows the algorithms to
improve themselves and compete with lower
transaction fees, the result may be a “zero
marginal economy“ with little or no transaction
fees, and no costs to switch among aggregation
platforms.

When machines serve other machines, the
opportunity to create value (and charge for
that value) comes not from customizing the
experience for a single consumer but optimizing
an aggregation of machines for an aggregation
of customers across the network.
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Merely publishing a request from a machine “customer”
will require:
• A complete listing of all potential providers of the product or service.
• Knowledge of each provider’s fixed and variable states. For the
charging station, for example, fixed state includes the payment
options/cryptocurrencies it accepts and which blockchains it
participates in, the number of charging poles and whether it offers
rapid vs. standard charging. Variable state would include how many
of its charging poles are occupied (and for how much longer, based
on the charging rates of the vehicles they are serving) or down for
maintenance, as well as expected future availability based on the
number of electric cars nearby and their battery status. It would also
include “ratings” from other autonomous vehicles about whether, for
example, the charging station correctly reported its availability and
charged the price it promised.
• Customization of offers (as price or delivery times) or style (the
attitude of a spoken voice or advertisement through a VPA) to meet
the current needs of a human or machine. Such customization requires
automated tools or manual effort to
analyze the selection algorithms currently
in use and how to best market to them,
as well as tools that let business users
easily make changes to content or style
of offers without coding and security
measures to avoid unauthorized changes
to content or offers.

Get With the Program, Humans
For an increasing range of products and
services, a person is no longer the decider
when it comes to purchasing products
and services. Designing products, business processes and user interfaces
only for people is not the skill that will determine winners and losers in
the machine economy.
In an age of smartphones, VPAs and ecommerce sites that automatically
compare prices, the next stop are automated, machine to machine buying
and selling. With humans increasingly replaced by (or at least helped by)
algorithms, everyone from product designers to marketers must think in
terms of developing products for machines, not people. The road to this
future will come in stages (See Figure Seven.) with the needs of (and the
potential for) autonomous machines rising steadily over time.
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Figure Seven: Road to Machine Economy
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Success in this new world requires understanding the unique needs of
machines (and the algorithms that drive them), building the technology
and skills to enable machine to machine interactions and the regulatory
and legal foundations to support it all.
We invite you to join us in shaping the processes, technologies and
thinking that will allow us to drive the most benefit from the emerging,
machine centered world, and to learn more about these and other
innovation thinking.
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